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3Willkommen bei prime:vocal

prime:vocal ist ein KI-gesteuertes Tool zur professionellen 
Vocal-Bereinigung und -Optimierung. Es ist sowohl als 
Standalone Application als auch als ARA-Plug-in (BE-
TA-Version) für die nahtlose Integration mit kompati-
blen DAWs verfügbar. Egal, ob du es mit nicht-idealen 
Aufnahmebedingungen zu tun hast oder einfach nach 
Sound in Studioqualität strebst – prime:vocal sorgt 
dafür, dass deine Vocals poliert und makellos klingen.

Die Anwendung bietet essenzielle Tools wie Noise- 
und Room Reduction, die dabei helfen, unerwünschte  
Elemente wie Hintergrundgeräusche, Reverb oder  
Microphone Bleed zu eliminieren. prime:vocal verbessert 
auch Gesangs- oder Sprachaufnahmen, indem es über-
betonte Zischlaute und Plosive intelligent reduziert. 
 
Für eine fortgeschrittene Optimierung deines Audios 
passt eine zusätzliche Dynamics-Funktion sowohl 
durchschnittliche als auch Spitzenpegel an, um ein pro-
fessionelles Levelling zu ermöglichen. Eine ausgleichende 
Steuerung ermöglicht es, das Signal bis hin zur optimalen 
Klangqualität zu verfeinern. 
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MacOS
 
Um den Installationsvorgang zu starten, öffne das  
Disk-Image sonible_primevocal_osx_x.x.x.dmg. Nun 
wird das Image eingebunden und ein Finder-Fenster 
geöffnet, das den Inhalt des Installationspakets anzeigt.

Um prime:vocal auf deinem System zu installieren, führen 
die Installationsdatei primevocal.pkg aus.

Das Installationsprogramm führt dich nun durch die  
notwendigen Schritte zur Installation von prime:vocal auf  
deinem Computer. Die Standalone-Version wird im  
Ordner Anwendungen installiert, während die Plug-in  
Version (ARA) in den Standardspeicherorten für Audio 
Plug-ins platziert wird. 

Audio Unit (ARA)
/Library/Audio/Plug-Ins/Components/

VST3 (ARA)
/Library/Audio/Plug-Ins/VST3/ 

Systemanforderungen 

Du benötigst Administratorrechte, um 
prime:vocal zu installieren. 

Windows
 
Um den Installationsvorgang zu starten, extrahiere die 
heruntergeladene Datei sonible_primevocal_win_x.x.x.zip 
auf deine Festplatte und führe das Installationsprogramm aus. 

Das Installationsprogramm führt dich durch die notwen-
digen Schritte zur Installation von prime:vocal auf dei-
nem Computer. Die Standalone-Version wird im Ordner 
Programmdateien installiert, während die Plug-in-Version 
(ARA) in den Standardspeicherorten für Audio-Plug-ins 
platziert wird.

VST3 (ARA)
C:\Program Files\Common Files\VST3\ 

CPU
Intel Core i (8. Generation)
Apple M1+

RAM
8GB

Operating systems
Windows 10+ (64 bit)
MacOS 11+

OpenGL Version 3.2+
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Unlocking

Nachdem du online eine Lizenz für prime:vocal erworben 
hast, erhältst du deinen Lizenzschlüssel per E-Mail. 

Maschinenbasiertes Unlocking 
Wenn du prime:vocal zum ersten Mal öffnest, wird 
ein Benachrichtigungsfenster angezeigt, das dazu  
auffordert, prime:vocal mit einem gültigen Lizenzschlüssel zu  
entsperren. 

Bitte stelle sicher, dass dein Computer mit dem Internet 
verbunden ist, bevor du mit dem Registrierungsprozess 
beginnst. Gib deinen Lizenzschlüssel ein und klicke auf 
„Register“. Die Software kommuniziert nun mit unserem 
Server, um zu überprüfen, ob die Lizenz gültig ist. Wenn 
ja – viel Spaß mit prime:vocal!  

iLok
Wenn du deine Lizenz auf einen iLok USB-Dongle über-
tragen hast, schließe den Dongle einfach an deinen  
Computer an. Wenn du die Lizenz in die iLok Cloud über-
tragen hast, stelle sicher, dass du vor dem Öffnen des  
Produkts eine Cloud-Sitzung startest. 
Wenn du die E-Mail nicht innerhalb von Minuten erhältst, 
überprüfen bitte zuerst den Junk-Ordner, bevor du dich an 
unseren Support wendest (support@sonible.com).

Trial version

Um prime:vocal im Demo-Modus auszuführen, klicken 
einfach auf “Try” und du kannst prime:vocal für ein paar 
Tage ohne Einschränkungen verwenden. (Besuche unsere 
Website, um mehr über den aktuellen Demozeitraum zu 
erfahren). Wenn der Demozeitraum abläuft, musst du eine 
Volllizenz erwerben, um das Produkt weiterhin nutzen zu 
können.

Anforderungen an die Internet-
verbindung 
sonible-Produkte benötigen nur während der Testphase 
und für die erste Lizenzaktivierung eine Internetverbindung. 
Während der Testphase muss die Internetverbindung jedes 
Mal bestehen, wenn das Plug-In verwendet wird. Sobald 
die Lizenz des Produkts erfolgreich aktiviert wurde, wird 
keine Internetverbindung mehr benötigt. 

Lizenzierungssysteme

Du kannst zwischen zwei Lizenzierungssystemen 
wählen: maschinenbasiert oder iLok. 

Durch die Erstellung eines Benutzerkontos auf www.
sonible.com und die Registrierung deiner Produkte – 
sofern diese nicht bereits im Dashboard sichtbar sind 
– kannst du deine Aktivierungen verwalten. 

Maschinenbasiert 
Mit jedem Lizenzschlüssel kannst du prime:vocal auf 
zwei Computern mit eindeutigen System-IDs installieren. 
Diese System-IDs werden während der Lizenzaktivierung 
berechnet. 

Die gleiche Lizenz kann von mehreren Benutzern verwen-
det werden, aber jeder Benutzer muss die Vollversion von 
prime:vocal unter seinem Konto einzeln freischalten. 

Bei Änderung einer System-ID (z.B. Austausch der Fest-
platte) kannst du das Produkt neben der jeweiligen Sys-
tem-ID im Dashboard deines sonible Benutzerkontos wid-
errufen/aktivieren. 

iLok
Wenn du eine Aktivierung auf dein iLok-Konto übertragen 
möchtest (iLok USB-Dongle oder iLok Cloud werden 
unterstützt), stelle sicher, dass das Produkt in deinem 
sonible-Benutzerkonto registriert ist. Klicke auf die Schalt-
fläche „Transfer to iLok“ neben dem Produkt in deinem 
Dashboard (www.sonible.com/my-account) und folge den 
Anweisungen.

Hinweis: iLok-Dongles der 1. Generation werden derzeit 
nicht unterstützt. prime:vocal
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Tab Bar 
Wechsle zwischen ver-
schiedenen Audiodatei-
en der aktuellen Sitzung 
(Standalone Application) 
oder verschiedenen Tracks 
(ARA-Plug-in). 

Zoom
Vergrößere/verkleinere die 
Zeitachse (horizontal) und 
die Amplitudenachse (ver-
tikal). Du kannst auch das 
Mausrad zum horizontalen 
Zoomen verwenden. 

Playback Controls & Timecode  
Steuere die Audiowiedergabe (Sprung zum Start, 
Wiedergabe/Pause, Stopp, Looping aktivieren) und 
überwache die aktuelle Abspielposition.

Output Gain 
 

& Metering  
Stelle einen Output Gain ein 
und überwache den RMS- 
und Peak Level des Aus-
gangssignals. 

A/B-Vergleich & Presets 
Verwende die A/B-Option, um zwei verschiedene Para-
metereinstellungen zu vergleichen und Presets zu speichern 
oder zu laden.

Track  
Overview Bar
Die Track-Übersichtsleiste 
zeigt die gesamte Audi-
odatei (Standalone Ap-
plication) oder den Track 
(ARA-Plug-in) sowie den 
Fortschritt des Analyse-
prozesses an. Klicke in die 
Track-Übersichtsleiste, um 
den jeweiligen Abschnitt 
anzuzeigen. 

Bypass & Diff
Benutze Bypass für die ge-
samte Verarbeitung oder 
hören dir die Differenz 
zwischen dem Eingangs- 
und dem verarbeiteten Aus-
gangssignal an.

Fine-Tuning Section 
Feinabstimmung der Verarbeitungsmodule durch An-
wendung einer Frequenzgewichtung für Noise und Reverb  
Reduction. Die Module Vocal Clean-up, Spectral  
Balance und Dynamics verfügen außerdem über zusätzliche  
Parameter zur Optimierung. 

Main Control Parameters
Steuere die Hauptverarbeitungsmodule: Noise Reduc-
tion, Room Reduction, Vocal Clean-Up (Sibilants, Plosive), 
Dynamik (Level Riding und Kompression) und Spectral  
Balance. 

Automation Panel
Überwache und steuere 
die Automatisierung von 
Parametern. 

Wave Form 
 

Display 
Überwache die Audio-Wel-
lenform. Zoome hinein, um 
zusätzliche Signale zu sehen 
– wie Rauschen und Nach-
hall sowie erkannte Sibilant- 
und Plosivabschnitte. 
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1.Laden von Audiodateien  
Es gibt zwei Möglichkeiten, Audiodateien zu laden:
•	 Laden über das Dateimenü: Du kannst eine oder 

mehrere Audiodateien über den Menüpunkt “File 
> Import Audio File” laden. (Weitere Informationen 
zum Dateimenü findest du auf Seite 20)  

•	 Loading via Drag and Drop: Du kannst eine oder 
mehrere Audiodateien per Drag & Drop direkt in das 
Anwendungsfenster von prime:vocal ziehen. Nach 
dem Laden wird ein neuer Tab mit dem Dateinamen 
erstellt und die Analyse der Datei startet automatisch.

2. Analyseprozess
Der Fortschritt des Analyseprozesses wird in der 
Track-Übersichtsleiste angezeigt. Sobald ein bestimmter 
Abschnitt der Datei analysiert wurde, kannst du mit der 
Arbeit an diesem Abschnitt beginnen. Teile, die noch nicht 
analysiert wurden, können erst wiedergegeben werden, 
wenn die Analyse abgeschlossen ist. 

INFO: Offline-Analyseprozess  
prime:vocal verwendet hochspezialisierte neuronale  
Netze, um Probleme in der Audiodatei zu erkennen und 
zu korrigieren. Diese Netzwerke erfordern relativ hohe  
Rechenressourcen. Das bedeutet, dass die vollständige  
Analyse einer Audiodatei (abhängig von der Hardware des  
Zielsystems) etwa die Länge der analysierten Datei benötigt 
(zum Beispiel dauert die Analyse einer 1-Minuten-Datei 
etwa 1 Minute).

Sitzungen 
Sobald eine oder mehrere Audiodateien in prime:vocal 
importiert werden, wird eine temporäre Sitzung erstellt.  

Wenn du zu einem späteren Zeitpunkt an einer  
Sitzung weiterarbeiten möchtest, kannst du die Sitzung 
als prime:vocal Session File (* .pvocproj) unter “File > 
Save Session” speichern. Die Sitzungsdatei speichert 
die Parametereinstellungen aller aktuell geöffneten 
Audiodateien. Außerdem werden alle Analysedaten 
in einem separaten Ordner namens “Analysis” neben 
der Sitzungsdatei gespeichert. Wenn du nach dem  
Export der Dateien keine weiteren Bearbeitungsschritte 
planst, kannst du prime:vocal einfach schließen und die  
temporäre Sitzung wird gelöscht.  

Hinweis: Die Dateigröße von prime:vocal-Analyseordnern, 
die mit einer Sitzung gespeichert werden, kann aufgrund 
der Menge an Analysedaten ziemlich groß werden. Für 
1 Minute Audiomaterial werden ca. 90 MB Analysedaten 
benötigt.

Erste Schritte (Standalone Application)

3. Beginne mit der Optimierung
Nachdem die Analyse abgeschlossen ist, kannst du 
die Einstellungen von prime:vocal nach deinem Bedarf 
anpassen. Alle Änderungen, die du vornimmst, werden  
sofort visuell und in der Audiowiedergabe abgebildet.

4. Audiodatei(en) exportieren
Sobald du mit den Ergebnissen zufrieden bist, kannst du 
die verarbeitete Datei einfach exportieren. Weitere Informa-
tionen zum Exportprozess findest du auf Seite 19. 



8Erste Schritte (ARA plug-in | BETA Version)

1. prime:vocal laden 
Lade prime:vocal als ARA-Plug-in. Der Prozess variiert je 
nach DAW - bitte wende dich an deinen DAW-Hersteller, 
um Einzelheiten darüber zu erfahren, wie die ARA-Integra-
tion in deiner spezifischen DAW implementiert wird.

2. Analyseprozess
Sobald das Plug-in geladen ist, analysiert prime:vocal alle 
Audioclips in der Spur. Der Analyseprozess kann je nach 
Länge der Clips einige Zeit in Anspruch nehmen. Wenn 
einer Spur neue Audioclips hinzugefügt werden, wird der 
Analyseprozess für die neuen Clips automatisch gestartet. 

Die analysierten Abschnitte eines Clips werden in der 
Track-Übersichtsleiste grün hervorgehoben und der 
gesamte Analysefortschritt aller Clips wird in einer 
Fortschrittsleiste angezeigt. Nicht analysierte Teile des 
Clips können erst wiedergegeben werden, wenn der Vor-
gang abgeschlossen ist. 

3. Beginne mit der Optimierung
Nachdem die Analyse abgeschlossen ist, kannst du die 
Einstellungen von prime:vocal nach deinem Bedarf anpas-
sen. Alle Änderungen, die du vornimmst, werden sofort 
visuell und in der Audiowiedergabe angezeigt.

Zusätzlich zu seiner Standalone Version ist prime:vocal 
auch als ARA (Audio Random Access) Plug-in in einer 
Betaversion verfügbar. Dieses fortschrittliche Plug-in 
Format ermöglicht eine Integration in kompatible DAWs*, 
so werden Workflows optimiert und der Export und er-
neuten Import von Audiodateien überflüssig macht.    
 
Hinweis: prime:vocal kann nur als ARA-Plug-in und nicht 
als Standard-Plug-in geladen werden. 

Was ist ARA 
 

(Audio Random Access)? 
Die ARA-Technologie verbessert die Kommunikation 
zwischen einem Plug-in und der DAW, sodass das Plug-in 
auf ganze Audiodateien oder Clips zugreifen kann, anstatt 
an Echtzeit-Audiodaten zu arbeiten. 

importieren und dann prime:vocal aus dem Projekt zu 
entfernen. 

* Die ARA-Version von prime:vocal (BETA) ist mit DAWs 
kompatibel, die das ARA-Protokoll unterstützen, wie z. B.:

•	 Steinberg Cubase/Nuendo
•	 Presonus Studio One
•	 Cockos REAPER
•	 Apple Logic Pro**

** Auf Apple Silicon muss Logic Pro im Rosetta-Modus 
ausgeführt werden, um ARA zu unterstützen. 

Beziehe dich auf das Handbuch deiner DAW, um  
sicherzustellen, dass ARA aktiviert und ordnungsgemäß 
konfiguriert ist.

4. Audio exportieren
Sobald du mit den Ergebnissen zufrieden bist, kannst du 
deinen Track oder dein Projekt einfach rendern lassen. 
Der Rendering-Prozess (Bouncing) ist identisch mit dem  
Rendering-Prozess bei Verwendung von Standard Plug-ins. 

Offline-Analyseprozess 
 

& Analysedaten 
prime:vocal verwendet neuronale Netze, um Probleme 
in der Audiodatei zu erkennen und zu beheben. Diese 
Netzwerke erfordern relativ hohe Rechenressourcen, 
was bedeutet, dass die vollständige Analyse einer Au-
diodatei (abhängig von der Hardware des Zielsystems) 
ungefähr die Länge der analysierten Datei benötigt (zum 
Beispiel dauert die Analyse einer 1-Minuten-Datei etwa 
1 Minute). Beachte auch, dass prime:vocal die gesamte 
Audiodatei analysiert, selbst wenn ein Clip nur am An-
fang oder Ende zugeschnitten wird. 

Die von prime:vocal generierten Analysedaten werden 
entweder im Medienordner deiner DAW-Projektdatei 
gespeichert (falls vom DAW unterstützt) oder in einem 
anpassbaren Ordner (siehe Allgemeine Einstellungen auf 
Seite 22), um sicherzustellen, dass die gesamte Verar-
beitung beim erneuten Öffnen der Sitzung intakt bleibt.

Die Analysedaten können ziemlich groß sein - etwa 
90 MB für 1 Minute Audio. Aus diesem Grund kann 
es hilfreich sein, den Track zu exportieren, der mit  
prime:vocal verarbeitet wurde, die optimierte Datei zu  
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Das Hauptdisplay zeigt einen Abschnitt der Wellenform der 
geladenen Audiodatei (Standalone Application) oder des 
Tracks (ARA Plug-in). 
 

Hauptanzeige 

mit Parameteranpassungen ändern. Wenn der angezeigte 
Bereich beim Herauszoomen 120 Sekunden überschreitet, 
wird nur das Eingangssignal angezeigt.

Der anzuzeigende Abschnitt des Signals kann über das 
Ansichtsfenster in der Übersichtsleiste ausgewählt werden 
(siehe Seite 17). Die Zoomstufe des angezeigten Signals 
kann sowohl horizontal (Zeitachse) als auch vertikal (Am-
plitudenachse) eingestellt werden. 

Angezeigte Signale  
Das Hauptdisplay zeigt zunächst nur das Eingangssignal 
an. Sobald die Analyse für einen Abschnitt abgeschlossen 
ist, werden zusätzliche Signalkomponenten (siehe unten) 
sowie das Ausgangssignal angezeigt, die sich in Echtzeit 

green: Noise Anteile pink: Hallanteile orange: Abschnitte mit Zischlauten oder Plosiven
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Das Noise Reduction Modul ermöglicht es, alle Signalkom-
ponenten oder -störungen aus dem Signal zu entfernen, 
die keine Stimme oder Sprache sind. Eine separate Fre-
quenzgewichtung (siehe Seite 12) ermöglicht eine Feinab-
stimmung des Clean-Up-Prozesses.

Beseitigung von
Hintergrundgeräuschen 
Typische Geräuschkomponenten sind statische Hinter-
grundgeräusche wie Lüftergeräusche, Klimaanlagen, elek-
trisches Brummen oder kurzzeitige Störgeräusche wie 
Türknallen, unbeabsichtigter Kontakt mit dem Mikrofon, 
Straßenlärm oder Trittgeräusche. 

Entfernung von Übersprechen 
Neben der Beseitigung typischer Geräusche ermöglicht 
prime:vocal auch die Entfernung unerwünschter Signalan-
teile von anderen Instrumenten – sogenanntes Microphone 
Bleed oder Übersprechen (Crosstalk). Diese Funktion ist 
besonders nützlich bei der Aufnahme mehrerer Quellen 
(z.B. Stimme und Gitarre), bei denen es schwierig ist, sie 
akustisch angemessen zu trennen.

Hinweis: prime:vocal ist darauf trainiert, Übersprechen 
zu erkennen und zu entfernen. Während die Software 
auch verwendet werden kann, um Gesangsspuren aus 
einem Audiomix zu extrahieren, wurde sie nicht speziell 
für diese Aufgabe optimiert - daher können die Ergeb-
nisse erheblich variieren. 
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Mithilfe von Room Reduction kannst du unerwünschte 
Einflüsse aus dem Raum (Reflexionen und Nachhall)  
reduzieren. Eine separate Frequenzgewichtung (siehe 
Seite 12) ermöglicht die Feinabstimmung des Effekts.

prime:vocal wurde speziell darauf trainiert, Raumgeräu-
sche in typischen, suboptimalen Aufnahmeumgebungen 
(z. B. Wohnzimmer, Proberäume, Live-Veranstaltungsorte) 
so sauber wie möglich zu erkennen und zu entfernen. 
Während das Tool auch verwendet werden kann, um 
sehr lange Nachhallzeiten zu reduzieren (z. B. künstlicher 
Reverb oder Nachhall in einer Kirche), ist es möglich, 
dass eine stärkere Verarbeitung in solchen Situationen 
unerwünschte Artefakte hervorrufen kann.

Room Reduction
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Mit der Frequenzgewichtung kannst du die Stärke der 
Noise Reduction und Room Reduction-Module separat 
über verschiedene Frequenzbereiche anpassen. Wenn ein 
Signal beispielsweise nur einen Geräusch-Anteil mit nied-
riger Frequenz enthält (z. B. das Brummen eines Transfor-
mators), kannst du den Impact der Rauschreduzierung in 
höheren Frequenzbereichen reduzieren. Obwohl prime:vocal 
extrem sauber arbeitet, bietet diese zusätzliche Feinab-
stimmung den Vorteil, potenziell unerwünschte Artefakte 
durch übermäßige Verarbeitung in bestimmten Bereichen 
zu vermeiden. 

Die horizontalen Linien ermöglichen eine erhöhte (>100) 
oder verminderte (<100) Auswirkung im entsprechenden 
Frequenzbereich. Wenn der globale Noise Reduction  
Parameter bereits seinen Maximalwert (100) erreicht hat, 
hat eine Auswirkung auf das Band >100 keinen Einfluss, 
da die maximale Reduzierung für dieses Band bereits  
angewendet wird.

Die Übergänge der drei Frequenzbänder können über die 
vertikalen Linien eingestellt werden. 

Mit dem Kopfhörersymbol kannst du den ausgewählten 
Frequenzbereich isoliert anhören. 

Frequency Weighting
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De-Essing  
Das De-Essing-Modul erkennt die Art der Zischlaute und 
macht es einfach, störende “s”, “z” oder “sh” Geräusche 
zu bearbeiten. 

•	 none: Das De-Essing-Modul ist deaktiviert.  
•	 soft: Leichte Minderung von störenden Zischlauten. 
•	 medium: Moderate Minderung störender Zischlaute. 
•	 strong: Starke Minderung der Zischlaute. In einigen 

Fällen kann dies zu unerwünschten Färbungen des 
Klangs führen.

De-Plosive  
Das De-Plosive-Modul erkennt die Art von Plosiven und 
macht es einfach, störende “p” -, “t” - oder “k” -Geräusche 
zu bearbeiten. 

•	 none: Das De-Plosive-Modul ist deaktiviert. 
•	 soft: Leichte Minderung von störenden Plosiven.
•	 medium: Moderate Minderung störender Plosive.   
•	 strong: Starke Minderung der Plosive. In einigen 

Fällen kann dies zu unerwünschten Färbungen des 
Klangs führen.

Mit dem Vocal Clean-up-Modul kannst du typische 
Probleme bei Gesangs- und Sprachaufnahmen  
bearbeiten, z. B. überbetonte Zischlaute oder Plosive.  

prime:vocal erkennt diese unterschiedlichen Signalkom-
ponenten automatisch und ermöglicht es, die Stärke der 
Reduktion für jeden Signaltyp separat anzupassen. 

Vocal Clean-up
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Das Dynamics-Modul kombiniert zwei wichtige  
Audioverarbeitungstechniken - Level Riding und  
Compression -, um einen ausgewogenen Dynamikbereich 
zu erreichen. Dies trägt dazu bei, dass deine Aufzeichnung 
ein konstantes Niveau behält und korrigiert unerwünschte  
Schwankungen.

Level Riding 
Level Riding passt den durchschnittlichen Pegel des  
Audiosignals an und erhöht oder dämpft ihn automatisch, 
um die Lautstärke während der gesamten Aufnahme  
konstant zu halten. Diese Technik hilft beim Verwalten der 
Gesamtlautstärke und stellt sicher, dass die Stimme oder 
Sprache eine konsistente Präsenz beibehält.

•	 Soft: Für sanfte Anpassungen an den Pegel 
und minimale Änderungen. Dies eignet sich für 
Aufnahmen mit geringen Volumenschwankungen, 
bei denen eine subtile Verbesserung erforderlich ist.   

•	 Medium: Wendet moderate Anpassungen an den 
Pegel an, berücksichtigt etwas auffälligere Lautstärken-
schwankungen. Ideal für Aufnahmen mit moderaten 
Schwankungen, die etwas mehr Kontrolle benötigen.   

•	 Strong: Für signifikante Anpassungen des Niveaus, 
wodurch größere Volumenschwankungen effektiv 
kontrolliert werden. Dies ist nützlich für Aufnahmen mit 
ausgeprägten Pegelschwankungen oder zur Erzielung 
einer sehr gleichmäßigen Lautstärke.

Compression 
Die Komprimierung reduziert den dynamischen Umfang 
des Signals. Dies trägt dazu bei, den Ton gleichmäßiger und 
kontrollierter zu machen. Dadurch wird verhindert, dass die 
Spitzen zu hoch und die weicheren Abschnitte zu niedrig 
sind. Durch die Kompression induzierte Pegeländerungen 
werden automatisch kompensiert.
 
•	 Soft: Bietet eine leichte Kompression, für eine minimale 

Reduzierung im Dynamikbereich. Diese Einstellung 
eignet sich für Aufnahmen, bei denen nur eine geringe 
Kontrolle über Spitzen und Tiefen erforderlich ist.   

•	 Medium: Für eine moderate Komprimierung, 
verwaltet den Dynamikbereich effektiv, für 
eine ausgewogenen Output. Verwende diese 
Einstellung für Aufnahmen mit moderater 
Dynamik, die etwas mehr Kontrolle erfordern.  

•	 Strong: Wendet starke Kompression an, um den 
Dynamikbereich deutlich zu reduzieren. Ideal für 
Aufnahmen mit großen dynamischen Variationen 
oder zur Erzielung eines sehr kontrollierten und 
gleichmäßigen Klangs.

Dynamics



15

Das Spectral Balance-Modul dient dazu, das Stimmsignal 
auszugleichen und alle spektralen Probleme oder Klang-
färbungen zu beseitigen, um sicherzustellen, dass das 
Signal sauber und präsent klingt.

In den erweiterten Einstellungen kannst du ein passend-
es Profil auswählen (Vocal Low, Vocal High, Speech 
Low, Speech High) und mit dem Color Parameter kann 
zusätzlich ein gewünschtes Timbre eingestellt werden, 
um die Verarbeitung an deine Präferenzen anzupassen. 

Profile
Die Profileinstellung bestimmt, wie das Spektrum, 
basierend auf der Art der Aufnahme, angepasst wird. 
“Vocal Low” und “Vocal High” sind für Stimmaufnahmen 
optimiert, während “Speech Low” und “Speech High” für 
Sprachsignale gedacht sind. Die Begriffe Low und High 
beziehen sich auf die Tonhöhe der Aufnahme, wobei 
Low für tiefere Stimmen und High für höhere Stimmen 
geeignet ist. 

Colour
Mit dem Colour Parameter kannst du den tonalen 
Charakter deiner Aufnahme anpassen. Durch die Einstel-
lung dieses Parameters kannst du beeinflussen, wie der 
Gesamtklang der Stimm- oder Sprachaufnahme geformt 
wird. Der Parameter bietet verschiedene Optionen (Warm, 
Neutral und Bright), welche die Frequenzbalance und die 
Klangqualität wie folgt beeinflussen: 

•	 Warm: Die Warm-Einstellung bietet einen satten, 
vollmundigen Klang, wobei der Schwerpunkt auf der 
Verbesserung der mittleren Frequenzen liegt. Diese 
Einstellung verleiht der Gesangs- oder Sprachspur 
eine angenehme Wärme und lässt sie geschmeidiger 
klingen. Die hohen Frequenzen werden leicht aufgewe-
icht, um ein angenehmes Hörerlebnis zu gewährleis-
ten und jegliche Härte zu vermeiden.

•	 Neutral: Die neutrale Einstellung sorgt für einen 
ausgewogenen Klang über das gesamte Frequenz- 
spektrum. Sie dient als Standardeinstellung für 
alle Profile und zielt darauf ab, den ursprünglichen 
Charakter der Aufnahme zu erhalten, ohne eine zusätz- 
liche Klangfarbe hinzuzufügen. Der Stil ist ideal, wenn 
du einen natürlichen, ungefärbten Klang wünscht, der 
für eine Vielzahl von Anwendungen geeignet ist. 

•	 Bright: Die Bright-Einstellung bringt ein Element der 
Luftigkeit und Glanz in deine Aufnahme, indem sie 
einen Akzent auf die hohen und High-Mid Frequenzen 
setzt. Diese Einstellung macht die Stimme oder 
Sprache lebendiger und präsenter und sorgt für 
Klarheit und Definition. Sie hilft, um Details zu betonen 
und die Aufnahme im Mix hervorzuheben. 

Spectral Balance
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Mit der Automatisierung (Automation) kannst du die Inten-
sität der Verarbeitung einzelner Module steuern. Beachte, 
dass nur die Hauptparameter jedes Moduls automati- 
siert werden können. Während die Automatisierung für ein 
Modul aktiv ist, kann der Parameter nicht manuell über den 
Bedienknopf eingestellt werden.

Das Automatisierungsfenster kann durch Klicken auf 
„Automation“ ein- oder ausgeblendet werden. Das 
Fenster zeigt für jedes Modul mit aktivierter Automati- 
sierung eine Automatisierungskurve an. 

Automation Curve Interactions
•	 Aktiviere die Automatisierung für ein Modul, um die 

entsprechende Kurve anzuzeigen.  
•	 Ein Doppelklick auf die Automatisierungskurve erstellt 

einen neuen Automatisierungspunkt.  
•	 Ein Doppelklick auf einen vorhandenen Automati- 

sierungspunkt löscht diesen Punkt.  
•	 Bewege die Automatisierungspunkte und die Linie 

zwischen zwei Punkten mit der Maus.  

Wenn du auf „Reset all“ klickst, werden alle Auto- 
matisierungspunkte für die aktuell ausgewählte Kurve 
gelöscht. Die Automatisierung kann verwendet werden, 
um bestimmte Anpassungen (z. B. Noise Removal) nur 
auf bestimmte Abschnitte anzuwenden. Dies könnte 
zum Beispiel nützlich sein, wenn eine Aufnahme Applaus 
enthält, der nicht herausgefiltert werden sollte.  

HINWEIS: Bei Verwendung der ARA-Version von  
prime:vocal kann die Standard-Automatisierung des DAW 
nicht angewendet werden. Im Gegensatz zu herkömm- 
lichen Plug-Ins verwenden ARA-Plug-Ins keine klassischen 
Parameter für die Automatisierung. Stattdessen müssen 
alle Anpassungen an den Einstellungen von prime:vocal 
direkt in der Plug-in-Schnittstelle vorgenommen werden.
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Transport Controls 
•	 jump to start: Sprung zum Anfang der Audiodatei 
•	 play/pause: Audio-Wiedergabe starten und anhalten  
•	 stop: Audiowiedergabe stoppen  
•	 loop mode: Ermöglicht die Wiedergabe eines aus-

gewählten Bereichs in einer Schleife. 

Tab-Leiste (Standalone Application) 
Jeder Tab stellt einen Track mit einer Instanz von  
prime:vocal dar. Durch Auswahl eines Tabs kannst du 
zwischen prime:vocal auf verschiedenen Spuren wechseln. 

Track Overview Bar  
Die Track-Übersichtsleiste zeigt die gesamte Wel-
lenform der geladenen Audiodatei (App) oder des 
Tracks (Plug-in) an. Der graue Fortschrittsbalken 
zeigt den gesamten Analysefortschritt an, die grüne  
Audio-Wellenform zeigt an, dass ein bestimmter  
Abschnitt bereits analysiert wurde. 

Loop-Bereich 
Um einen bestimmten Abschnitt des Signals in einer 
Schleife wiederzugeben, kann ein Loop-Bereich definiert 
werden. Wenn der Loop-Modus aktiv ist, beginnt die Wie-
dergabe immer zu Beginn des Loops. Am Ende des Loops 
springt der Abspielkopf ohne Pause automatisch an den 
Anfang zurück.	  

Um einen Loop-Bereich zu erstellen, wähle den entsprech-
enden Signalabschnitt im Hauptdisplay oder auf der Zeit-
achse aus, indem du ihn von links nach rechts markierst. 

Tab-Leiste (ARA Plug-in) 
Jeder Tab stellt einen Track mit einer Instanz von prime:vo-
cal dar. Durch Auswahl eines Tabs kannst du zwischen 
prime:vocal auf verschiedenen Spuren wechseln. 

View Window 
Im ‘View Window’ kannst du den Teil der Audiodatei aus-
wählen, der im Hauptdisplay angezeigt wird.

•	 Bewege das Fenster nach links oder rechts, um zu 
einem anderen Abschnitt der Audiodatei zu springen.  

•	 Ziehen den linken oder rechten Rand, um den im 
Hauptdisplay angezeigten Abschnitt der Audiodatei zu 
vergrößern oder zu verkleinern. 

Sobald ein Loop-Bereich erstellt wurde, wird der Loop-
Modus automatisch aktiviert. Du kannst den Loop-Modus 
ein- und ausschalten, indem du auf das Loop-Symbol im 
Abschnitt Transport Controls klickst. 

•	 Die Größe des Bereichs kann durch Bewegen der 
beiden Loop-Grenzen eingestellt werden.  

•	 Der gesamte Bereich kann durch Ziehen des 
ausgewählten Bereichs nach links oder rechts 
verschoben werden. 

•	 Für das ARA-Plug-in wird der Loop-Bereich mit den 
Loop-Einstellungen der DAW synchronisiert (falls 
unterstützt). 

A/B & Presets
Verwende die A/B-Option, um zwei verschiedene Para- 
metereinstellungen zu vergleichen und Presets zu 
speichern oder zu laden. 

Zeitleiste   
Die Zeitleiste zeigt die aktuelle Wiedergabeposition in 
Stunden, Minuten und Sekunden an:
•	 Verwende das Mausrad zum Vergrößern/Verkleinern.  
•	 Klicke und ziehe den Cursor nach links oder rechts auf 

der Zeitachse, um einen Loop-Bereich zu erstellen. 
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Der Abschnitt des anzuzeigenden Signals kann über das 
Ansichtsfenster in der Spurübersichtsleiste ausgewählt 
werden (siehe Seite 12). Die Zoomstufe des angezeigten 
Signals kann sowohl horizontal (Zeitachse) als auch ver-
tikal (Amplitudenachse) eingestellt werden. 

Zoom-Amplitudenachse 
•	 Verwende den Schieberegler für den vertikalen Zoom. 

Beachte, dass das Zoomen auf der Amplitudenachse 
rein visuell ist und keinen Einfluss auf den tatsächlichen 
Pegel des Ausgangssignals hat.  

Zoom Zeitachse 
Es gibt drei Möglichkeiten, die Zeitachse zu vergrößern: 

•	 Verwende das Mausrad, während sich der Cursor 
im Hauptanzeigefenster, auf der Zeitleiste oder in 
der Spurübersichtsleiste befindet

•	 Verschiebe die Kanten des Ansichtsfensters nach 
links oder rechts  

•	 Verwende den horizontalen Zoom-Slider
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Sobald du mit dem Ergebnis der Verarbeitung zufrieden 
bist, kann die bearbeitete Audiodatei exportiert werden. 

Exportieren über das File-Menü
Einzelne Audiodateien können über den Menüpunkt 
„File > Export Audio File“ exportiert werden. 

Alle Dateien in einer Sitzung können über „File > Export 
All Audio Files“ exportiert werden.  

Ein ausgewählter Loop-Bereich einer Datei kann über 
„File > Export Selection“ exportiert werden. 

Export-Einstellungen 

Beim Export von Audiodateien können die folgenden  
Parameter konfiguriert werden. Die meisten Parameter 
sind für jede Art von Export verfügbar - einige Parameter 
(z. B. bestimmte Namensschemata) sind nur beim Export 
mehrerer Dateien verfügbar. 

Format 
*.wav 
*.aiff 
*.ogg 
*.flac 

Sample Rate 
22.05kHz, 44.1kHz, 48kHz, 88,2kHz, 96kHz 

Bit Depth (nur verlustfreie Formate)
16, 24, 32 

Normalisierung 
•	 off: keine Normalis-

ierung anwenden
•	 Loudness [LUFS]: auf 

eine durchschnittliche 
Lautstärke normalis-
ieren 

•	 Peak [dB]: auf einen 
bestimmten maximalen 
Pegel normalisieren 

•	 Target Level: Stellen 
einen Zielpegel (LUFS 
oder dB) für die Nor-
malisierung ein.  

Naming
•	 Custom: Export mit 

benutzerdef iniertem 
Namen 

•	 Original: Export mit 
Originalname 

•	 Original + Suffix:  
Export mit Originalname 
+ gewähltem Suffix  

•	 Custom + Number: 
benutzerde f in ie r te r 
Name + fortlaufende 
Nummerierung (nur 
für den Export aus 
mehreren Dateien)

Bitrate (nur verlustbehaftete 
 

Formate)
128, 192, 256, 320 
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File-Menü 

Import Audio File 
Importiere eine neue Audiodatei in die aktuelle Sitzung. 

New Session 
Erstelle eine neue, leere Sitzung in einem neuen  
Anwendungsfenster.

Open Session
Öffne eine vorhandene prime:vocal-Sitzung. 

Save Session
Speichere Sie die aktuelle Sitzung als PVXX-Datei. 

Save Session as 
Save the current session under a new name. 

Remove Audio File 
Entferne die Audiodatei, die dem derzeit aktiven Tab zu-
geordnet ist, aus der Sitzung. 

Export 
Exportiere die bearbeitete Audiodatei, die dem aktuell 
aktiven Tab zugeordnet ist. 

Export all 
Exportiere alle bearbeiteten Audiodateien, die der  
aktuellen Sitzung zugeordnet sind. 

Export Selection 
Exportiere den bearbeiteten Loop-Bereich des aktuell  
aktiven Tabs. 

Close Session 
Schließe die aktuelle Sitzung. Beachte, dass nicht  
gespeicherte Änderungen verloren gehen. 

Close all Sessions 
Schließe alle aktuell geöffneten Sitzungen (Anwendungs-
fenster). Beachte, dass nicht gespeicherte Änderungen 
verloren gehen. 

Menüleiste (Standalone Application)
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Ein Preset speichert die auf die aktuelle Datei angewendeten 
Einstellungen.  

Um ein Preset zu speichern, klicke neben dem Preset-Drop-
down-Menü auf „Save“. 

Um ein gespeichertes Preset zu laden, wähle den entspre-
chenden Preset-Namen aus dem Dropdown-Menü aus.

Um ein Preset zu löschen oder die Benennung zu ändern, 
gehe zum Preset-Ordner in deinem lokalen Datei-Explorer.   

Du kannst deine Voreinstellungen einfach zwischen  
verschiedenen Workstations teilen. Alle Voreinstellungen 
werden mit der Dateiendung „.spr“ in den folgenden  
Ordnern gespeichert: 

Preset Folders  
macOS: ~/Library/Audio/Presets/sonible/primevocal 

Windows: My Documents\Presets\sonible\primevocal Presets  
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Um die Einstellungen aufzurufen, klicke auf das Zahnrad 
in der oberen rechten Ecke oder gehe zum Menüpunkt 
„Edit > Preferences“ (Standalone Application). 

Allgemeine Einstellungen

Use OpenGL  
OpenGL kann auf bestimmter Computerhardware zu 
Rendering-Problemen führen. Verwende diese Option, 
um OpenGL zu deaktivieren.   

Plug-in Information  
Hier findest du den Namen und die Version deiner Soft-
ware. Start the welcome tour – eine kurze Übersicht über 
die Funktionen, wenn du auf „Show Tutorial“ klickst. 

Share anonymous 
 

user data with sonible  
Aktiviere die Freigabe vollständig anonymisierter  
Benutzerdaten an sonible und hilf uns, die Anwendung zu 
verbessern. 

License Information  
Zeigt deinen Lizenzstatus und deine Lizenznummer an 
(wenn nicht über iLok lizenziert). 

Update Notice  
Wenn eine neue Version des Tools verfügbar ist, erhältst 
du eine Benachrichtigung. 

Store Analysis Data With Project  
Aktiviere diese Option, um die Analysedaten im  
Medienordner deines DAW-Projekts zu speichern. 
Bitte beachte, dass nicht alle DAWs diese Option  
unterstützen. Wenn die Option nicht unterstützt wird, wird 
der Analysis Data Folder (siehe unten) verwendet. 

Size of Control Elements
Definiere eine Standardgröße für alle Bedienelemente  
(z. B. Slider). 

Analysis Data (Folder)
Wenn deine DAW die Speicherung im Mediendatenordner 
nicht unterstützt oder wenn du die Optoin deaktiviert 
hast (siehe oben), wird dieser Ordner für deine Analyse-
daten verwendet. 

Der Standardordner für Analysedaten ist der Ordner  
„Music“ im Benutzerverzeichnis:

Mac: ~/Music/sonible/primevocal

Windows: C:\Users\<user>\Music\sonible\
primevocal
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Audioeinstellungen 
(Standalone Application)

Output device 
Wähle das Audiowiedergabegerät. 

Active output channels
Wähle die Kanäle aus, die für die Wiedergabe  
verwendet werden sollen. 

Sample Rate
Definiere eine Sample Rate. 

Buffer Size
Definiere eine Puffergröße für deine Audiowiedergabe. 

Standardexporteinstellungen 
(Standalone Application)

Im Exportbereich kannst du das Standard-Export- 
format definieren. Die hier definierten Einstellungen werden 
auch beim Export einer Audiodatei per Drag & Drop z.B. in 
eine DAW verwendet.  

Weitere Informationen zu den spezifischen Export- 
einstellungen findest du auf Seite 19.
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